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===========================================================================
1. Distribution
===========================================================================
This version of PEDIGREE Program may be distributed with the following limitations:
GENERAL
PEDIGREE may be distributed free of charge; there can be no fee charged for the
distribution of PEDIGREE other than reasonable media charges. PEDIGREE may only be
distributed in its entirety — the archive format may be changed, but all of the files in the original
archive must be included in the new archive.
The limitations specified in this section are not designed to interfere with your use or
distribution of the program; they are designed to protect the interests of the programmer.
===========================================================================
2. Disclaimer
============================================================================
PEDIGREE (“THE SOFTWARE”) DOES NOT COME WITH ANY WARRANTY, EXPRESS
OR IMPLIED. IF YOU MAKE USE OF THE SOFTWARE, PLEASE BE AWARE THAT YOU
DO SO AT YOUR OWN RISK. NEITHER THE AUTHOR OF THE SOFTWARE NOR ANY
OTHER PARTY WILL ACCEPT RESPONSIBILITY FOR ANY DATA LOSS, EQUIPMENT
DAMAGE, OR OTHER UNFORESEEN CONSEQUENCES OR DAMAGES THAT ARISE AS A
RESULT OF THE USE OR MISUSE OF THE SOFTWARE.
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Introduction This Pedigree Program allows the user to generate a list of
dogs (up to 32,767 entries) including conformation and obedience/field title status and establishes linkages with the dog's
sire and dam. After these linkages are set, a 5-generation pedigree file (backward looking), or a 6-generation progeny file (forward looking) can be written as a text file for later printing using
any word processing program. The program also allows the
pedigree or progeny files to be previewed and printed at the
time they are created. In order to use the program the dynamiclink library file for MS Visual Basic, Version 3.0,
VBRUN300.DLL (included) must be installed on your computer,
usually in the Windows directory. Computer memory resources
may limit the total number of entries per list and the number of
associated records.
The Pedigree Program also allows note files, show
records, medical records, litter records,show entry forms and
ownership/breeding records to be accumulated for each dog in
the list, and, if BMP graphic files are available in approximately
200 x 200 pixels size, these pictures can be called up when that
dog's name is entered in the NAME box. The dog list file,
records and the graphics files should be placed in the same
directory. If desired, more than one dog list file and associated
records and pictures may be maintained, but each such set of
records should be put in a separate subdirectory. The convention for naming the files uses the dog's index number in the list
(e.g., for a dog indexed as number 35 in the list the associated
records file is called 0035PEDI.REC). Similarly, the picture file
for a scanned picture of this dog should be named
0035PICT.BMP in order to be found by the program.

An Income & Expenses record can be generated to track the
costs associated with the maintenance and showing of the
dogs. This function is accessed from the menu selections on
several of the forms. It is a text file which will be named
PEDICOST.FNC and when saved will be stored in the active
folder.

Getting Started The program initiates with the main Pedigree form.
1. If no previous list of dogs exists, a new list must be generated by using the program in the NEW FILE mode. Select
NEW FILE under the FILE, OPEN FILE menu, then open the
new file using a valid filename. Use the Windows 3.1 naming
convention- (no more than 8 characters.PDG).
2. Begin entering dog names by typing in the NAME box
(type in the center sector - leading and ending sectors are reserved for conformation and obedience/field titles, respectively).

After each entry press the carriage return button or click on
SAVE and CLEAR to enter the names in the LIST box. They
will automatically be sorted alphabetically as they are entered.
Do not try to enter new names in the SIRE and DAM boxes; all
new entries should be typed in the NAME box.
3. After all the names have been entered, SAVE the file
from the FILE menu. For long dog list files, the displayed region will automatically scroll to keep the current position visible.
4. Click on SAVE and CLEAR only ONCE for any entry.
Otherwise duplicate listings may be entered in the LIST box. If
a mistake is made, it can be corrected later in the MODIFY FILE
mode, but if the entry is already indexed to records and pictures, duplicate entries may be difficult to correct.
5. To DELETE an entry, you should first assure that there
are no sire or dam links to the entry you want to delete. If there
are, you will need to link these to the correct entry (or to the
blank) while in the MODIFY FILE mode. An entry can be deleted by double clicking on the entry name in the list box and
then clicking the DELETE button which will appear. When the
file is saved from the FILE menu, the list of dogs will decrease
by the number of entries deleted and the index numbers will be
shifted accordingly.
6. After entering the names, the file should be opened for
MODIFY (FILE MENU - OPEN FILE- MODIFY FILE) to set up
the sire and dam linkages. It is possible to switch the file mode
from the FILE MENU. This may be more efficient than saving,
closing, and re-opening the file, but it will save the modified file

using the same file name and cause the old file to be overwritten without warning.
7. Highlight the dog's name from the LIST box and click on
the Name option button to load the dog in the NAME box.
8. You can then highlight the sire's name in the LIST box
and enter its name in the SIRE box by clicking the button in
front of that box. The dam's name can be entered in the DAM
box in the same manner.
9. After these entries have been made, click on the SAVE
and CLEAR button to save the sire/dam linkages. If you prefer,
you can start to type the sire or dam name in the proper box; the
dog list will scroll to display your entry, and if it exactly matches
a dog already listed, it will be properly linked after a carriage
return is entered and the SAVE and CLEAR button is clicked.
10. Entering conformation (Pre-) and obedience (Post-)
titles can be done in several ways. The titles can be typed directly in the appropriate spaces next to the NAME box, or the
titles can be selected from the title list boxes which each include
a blank for no title then click on the Insert Title button to enter
the titles in the appropriate spaces (or you can double click on
the entry in the title list box). You must click on SAVE and
CLEAR for the changes to be recorded.
11. Note files can be generated for the dog entered in the
NAME box while in the MODIFY mode. If a note file already
exists for the entry, a green bar appears in the check box next to
the NOTES button. Clicking on the NOTES button will then

load that file which can be amended and saved. If no file exists,
you can click on NOTES, type the entries for Reg. No., Date of
Birth, Breeder, Sex, Owner, Color, CERF, OFA, and BAER in
appropriate boxes, then type the note for optional additional information about the dog, and click on the SAVE button to save
to file. To facilitate searches, breeder and owner names should
be entered in the format: Smith, John.
12. If a picture of the dog entered in the NAME box is in
the current directory, a green bar appears next to the PICTURE
button, the PICTURE button is enabled, and clicking on that
button will load the picture. It is automatically unloaded when a
new entry is made in the NAME box.
13. To access the Medical Record for the dog currently
entered in the NAME box, click on the menu item RECORDS
and then select Medical Record. Similarly, to access other
records click on RECORDS and then make the selection. You
will not be able to change and save any of the data in these
records if the dog list file was opened as Read Only.
14. To satisfy the AKC requirements for record keeping,
"Regulations for Record Keeping and Identification of Dogs, Jan
20, 1994," you are required to keep a separate printed copy of
all required records. Current printouts of the Litter Records and
the Ownership Records should be maintained for all dogs
owned or leased and kept for a period of at least five years after
the dog has died, been sold or given away.
15. The pedigree file can be generated by using the
PRINT option under the FILE menu. The file will be placed in

the current directory for later manipulation using a word processing program. In order to have the spacing come out right
you will need to print the file using a monospace type font (such
as COURIER or LETTER GOTHIC). You can also preview and
print the file directly from the Pedigree program.
16. The program workspace can be personalized by selecting the background color, wallpaper and font from the OPTIONS Menu. After exiting from the program, these selections
will be saved in the file PEDIGR.INI which will be used to initialize the program when next started.

RECORDS
Litter Record The litter record can be used to keep track of litters produced by bitches selected from the dog list and entered in the
NAME box. Completed record forms can be used to track the
data in accordance with the requirements of AKC regulations.
The dam's name is entered when a new litter form is
called. Other data must be entered in the appropriate boxes.
These data will be saved in the Litter Record part of a file
named, e.g., 0047PEDI.REC for the bitch with index number
47.
The disposition of
each puppy is recorded
by entering data in the
input boxes directly
above the data grid. The
keyboard tab key can be
used to move the cursor
between the boxes or the
mouse can be moved to
the box and clicked to
begin typing. After completing the entries, clicking on the Enter button (or carriage return if in the final box) moves the data into the grid and clears
the input boxes. A maximum of 17 rows are provided for listing
the puppies. The data will be entered in the first row with no
entry in the first column (sex column). N.B. , if you do not have
a data entry in the first column, the rest of the table beyond that

point will not be saved.
To correct erroneous data double-click on the item in the
data grid that is to be replaced. Typing corrected data in the
input box above the item to be corrected and clicking on the
Enter button will replace the data with the corrected entry. More
than one item in the same row (or even the entire row) can be
corrected simultaneously using this method. If there are no
data in any of the input boxes, the entire grid row will be deleted.
Litters from the same bitch should be numbered sequentially. They can be called up by clicking on the File Menu and
then on Open File. The litter number must be entered in the
input box to call up the record. To start a new litter record enter
the next higher number than the last litter recorded. This program provides for a maximum of ten litters. The form can be
printed by clicking Print from the File Menu.
After all new data have been entered, clicking on Save
under the File menu saves the updated record.
The font selection made from the options menu of the
main Pedigree screen will affect the display font in the data grid
for 800 x 600 screen resolutions.

Medical Record The medical Record File is used to record vaccinations,
examinations and veterinary treatments. The record for the dog
entered in the NAME box will be called up when the menu
Record is clicked and the Medical Record is selected.
If not already entered, Date of birth, Veterinarian and
phone number should be entered in the appropriate boxes.
When the save button is clicked these data will be saved to file.
Vaccination dates and Examination dates should be entered in
the corresponding boxes under Current. Date Due entries can also be
made or you may accept the
program's default values. The Date
Due entries will be color-coded to
reflect the need to update vaccinations or exams (red for past
due, amber for due within 30 days). Program default values for
all exams and vaccinations other than rabies are set to one
year. The rabies default value for puppies is one year and for
adults three years. The medical record has two extra spaces for
user options. Select and delete the square brackets and enter
your preferences. The date due for these is set to 1 year post
vaccination. The estrus block sets the due date to 6 months
post last. The Record of Treatments box should be used to
record office visits, treatments, seasons for bitches, breeding
notes, etc.
It is important to click the Save button before clicking on
the Close button, otherwise the file will not be updated to reflect
the changes that have been made.

Ownership Record The ownership record can be used to record significant
data on each dog. This data form includes the information required for record keeping by the AKC. The breeding list should
be completed for each
dog and bitch owned.
The dog's name
(and sire and dam) is
entered for the dog currently entered in the
Name box. Other data
must be entered in the
appropriate boxes.
These data will be saved
in the Owner record of a
file named, e.g., 0047PEDI.REC, for the dog with index number
47.
The breeding entries for each mating are recorded by entering data in the input boxes directly above the data grid. The
keyboard tab key can be used to move the cursor between the
boxes or the mouse can be moved to the box and clicked to begin typing. After completing the entries, clicking on the Enter
button (or carriage return if in the final box) moves the data into
the grid and clears the input boxes. The data will be entered in
the first row with no entry in the first column (date of mating column). N.B. , if you do not have a data entry in the first column,
the rest of the table beyond that point will not be saved.
To correct erroneous data double-click on the item in the
data grid that is to be replaced. Typing corrected data in the

input box above the item to be corrected and clicking on the
Enter button will replace the data with the corrected entry. More
than one item in the same row (or even the entire row) can be
corrected simultaneously using this method. If there are no
data in any of the input boxes, the entire grid row will be deleted.
The form can be printed by clicking Print from the File
Menu.
After all new data have been entered, clicking on Save
from the File Menu saves the updated record.
The font selection made from the options menu of the
main Pedigree screen will affect the display font in the data grid
for 800 x 600 screen resolutions.

Show/Trial Record The Show/Trial Record File can be used to keep track of
show, field trial, obedience trial, agility trial entries and results.
The record for the dog entered in the NAME box will be called
up when the Record menu is clicked. Clicking one of the tabs
at the top of the form will switch to that record.
If not already entered, AKC Registration number, Breeder
identification and dog's
Date of Birth can be entered by typing in the appropriate boxes. When
the record is saved these
data will be saved as
well.
Updates can be
entered by typing in the
input boxes directly
above the data grid. The
keyboard tab key can be used to move the cursor between the
boxes or the mouse can be moved to the box and clicked to begin typing. After completing the new entries, clicking on the
Enter button moves the data into the grid and clears the input
boxes. The data will be entered in the first row with no entry in
the first column (date column). N.B. , if you do not have a data
entry in the first column, the rest of the table beyond that point
will not be saved.
To correct previously entered data double-click on an entry for the line or item(s) to be replaced. Clicking on the Enter

button will then replace the selected line with the new data in
the input boxes. Single item entries can be corrected by leaving all the input boxes blank except the item to be corrected. If
there are no data in any of the input boxes, the entire grid row
will be deleted.
After all new data have been entered, clicking on the Save
to File button saves the updated record.

Income & Expenses Record The Income & Expenses record form is accessed from the
menu bars of the Main form and the Litter, Medical, Ownership
and Show records.
To use this record select a tab from the categories:
General
Show
Breeding
Veterinary
To enter new data select a
new row by scrolling the index
to a new number or click on the
index (left) column in the grid at
the first unused row. Enter the
date, amount and description of
the transaction and select the
option, income or expense.
Click the Enter button to move
the data into the grid. scroll the index to the next unused row to
continue entering more data.
To delete an item select the item from the grid and click on
the Delete button. To change the entry select the item from the
grid, enter the new data in one of the input boxes above the grid
and click the Enter button.
To delete multiple entries select the region by depressing

and dragging the mouse in the grid and then clicking the Delete
button.and dragging the mouse in the grid and then clicking the
Delete button. To select an entire row click in the numbered
box to the left of the row. To select an entire column click in the
column title box at the top of the column. To select the entire
grid click on the box in the top left corner of the grid. Hitting the
delete button will delete everything in the selected region.
To save the data to file (which will be placed in the active
folder and named PEDICOST.FNC) click on the Save button.
Only those grid rows will be saved that have data entered in the
"Amount" column. If this item is blank, the data in that row will
not be saved.
The record can be printed by selecting the Print option under the menu item: Expenses.
You can also rename or delete records from the menu.
When renaming, select a new name when requested (up to 8
letters - no spaces, no extension); the DOS extension .FNC will
be added. Care should be exercised when deleting records,
since deleted records cannot be recovered.

PROCEDURES
Menu Bar By clicking the FILE menu bar and selecting OPEN FILE
- (READ ONLY, NEW FILE, MODIFY FILE or APPEND FILE) a
file selection box appears.
Selecting the drive, the directory, and the filename (if it
already exists) and clicking on OK will open the file.
Selecting the drive, the directory, and typing a new
filename in the box while in the NEW FILE mode will open a
new file. To expedite data entry or modification it is possible to
switch the file mode from NEW FILE to MODIFY, from MODIFY
to APPEND, or from APPEND to MODIFY. This switching does
not allow the user to specify a new file name but overwrites the
old file.
Printer setup options are available, and pedigree, progeny or AKC show entry files can be produced, previewed and
printed. It is also possible to generate 4- or 5-generation pedigree files in HTML format for publishing on a web page and to
launch MS Word© or MS Excel© programs.
It is possible to DELETE or RENAME dog list files from the
FILE menu. These procedures are only available when a file is
opened for MODIFY.
Use extreme care in using the DELETE option since this
procedure does not allow recovery from the Recycle Bin. Any

records and pictures that may be associated with the deleted
dog list, however, are not deleted, and these must be removed
manually.
Renamed dog list files must be placed in the original folder.
Renaming the dog list will not change the links to associated
records and pictures.
Printer setup options are available, and pedigree, progeny or AKC show entry files can be produced, previewed and
printed. It is also possible to generate and preview 4- or 5-generation pedigree files in HTML format for publishing on a web
page.
Selecting LAUNCH VISIBLE COI will start the "Visible COI"
program if you have that program installed. The first time you
select this option you will need to locate the program. This location will be stored in the .ini file. Subsequent calls will
launch immediately unless the .ini file has been deleted. The
call to the "Visible COI" program from Pedigree will load the currently opened dog list and calculate and display the 5-generation COI for the selected dog.
Selecting RUN TEMPLATE APPS provides the option to
launch MS Word or MS Excel and, if you have preloaded the
required template or worksheet, to construct formatted pedigrees using these applications.
EXPENSES accesses the Income & Expenses record
which allows the user to record, save and print transactions involving general, show, breeding, and veterinary expenses.

EDIT allows the usual CUT, COPY, PASTE functions, and
SEARCH provides options to search on Breeder's Name,
Owner's Name, Date of Birth, CERF, OFA, and BAER results.
For a breeder or owner name search enter the last name only;
capitalization is disregarded but, otherwise, the search routine
requires an exact match with your search criterion. With a dog
list open in the Modify File mode and a dog selected in the
Name box, you can use DELETE RECORD to erase a section
of the selected dog's record. You can also erase the entire
record file for the selected dog.
OPTIONS allows you to change fonts and color. This is
more important when using a lower resolution (800 x 600)
screen mode. A smaller font size should be selected so that the
text fits entirely in the space provided. The screen font selection will also affect the data grid in the Litter and Ownership
records in the 800 x 600 mode.
It is possible to merge two separate dog list files into a
single file, but available computer memory may limit the size of
the files that can be merged. Use the Browse command to select the files to be merged. This option is only available when
there is no dog list file currently open.
Some CSV-type dog lists created using other programs or
exported as ASCII (text) data records from database programs
can be converted to the PDG dog list format used by Pedigree.
Dog lists that have been imported can be audited for duplicates
and sire or dam mis-linkages after the import routine has completed. Subsets of the dog lists can be exported for use with
other programs.

By selecting Preferences you can insert search preferences that replace several of the default categories that are displayed in the NOTES section.
The Autoscroll Dog List option can be used to toggle the
automatic scrolling operation of the dog list box. The default
option enables autoscrolling when the menu option is checked.
Unchecking the option will limit the automatic scrolling for dog
lists that have more than 1000 entries.
The Auto backup on Save/Delete option provides automatic
creation of backup dog lists (.bak file) whenever a save or delete file request is executed. This includes mode switching between Modify and Append. To recover the previous dog list you
will need to copy the .bak file and change the extension to .pdg.
PICTURE Menu allows you to load, autosize, save and
link picture files. These pictures, if saved, will be saved as
BMP files indexed to the dog currently selected.
RECORDS Menu lets you select the Medical Record,
Show/Trial Record, Litter Records or Ownership Record and to
create new records or update existing records for the dog currently selected in the NAME box.
HELP Menu displays the help screen. Help topics may
also be printed if a printer is available.

Index Number The dogs' names appearing in the list box are sorted alphabetically, but the specific INDEX number assigned to any
dog is sequential according to the order in which you entered
the names and does not change unless entries are deleted or
files are merged.
The index number assigned to a dog is the same number
that is used in the file names for that dog's note file, picture file,
and records. Index number one is reserved for the blank entry
and appears as the first entry in the list of dog names.
While in the Read Only mode you can type the index number of
a dog in the box above the dog list. When you hit enter (CR),
the list will scroll to that dog.
If you have more than one dog list, you should keep them
in different subdirectories. Otherwise associated records
(notes, pictures, medical records, etc) with the same index number will be improperly cross-referenced and can be
inadvertantly overwritten.

Dog List The dog list will appear in the list box which can be
scrolled to the selected entry, clicking on that entry selects it.
Then clicking on the NAME button loads that name into the
NAME box for correction and additions or for accessing
RECORDS and PICTURES.

Although ONLY the dog entered in the NAME box can be
edited, a similar method may be used to enter the names of the
Sire and the Dam in the appropriate boxes.
To delete a dog’s name from the list, you can double click
on the name and then click on the Delete button.

File Opening Mode Only one mode can be selected. A choice is made from
the FILE menu before an existing dog list file can be opened or
a new one created. A dog list file must be opened before any
data can be entered.
READ ONLY can be used for reviewing an existing dog
list and associated records. No records can be modified and
saved while in this mode.
NEW FILE is used to start a new dog list by entering the
dog names in the NAME box (as in the APPEND mode). A new
file name can be entered directly in the file menu dialog or an
existing file can be opened after the mode has been selected.
MODIFY FILE corrects current entries in the dog list when
they are selected and entered in the NAME box; this mode is
also used to enter sire/dam links, new titles, creating and editing records and notes, etc.
APPEND FILE can be used to add to an existing dog list
by entering new names in the NAME box and then clicking the
SAVE & CLEAR button or entering a carriage return.
While in the NEW FILE or APPEND TO FILE modes, and if the
dog's sire and dam have already been added to the dog list,
you can set these links immediately by selecting from the list
and clicking the SIRE or DAM button, as appropriate. You can
also add the titles and NOTES search data, i.e., AKC number,
breeder, owner, etc. These sire/dam links and other data, how-

ever, must be entered before clicking the SAVE and CLEAR
button.
It is possible to rapidly switch the file mode from the FILE
Menu. When this option is clicked the file is saved using the
old file name, and the old file is overwritten.
Lists of dogs should be saved in files with a suffix .PDG
(default setting). The program does not accept long file names;
you must limit the file name length to 8 characters in addition to
the suffix .PDG. These dog list files are text files and can be
reviewed by using a text editor such as NOTEPAD.
The program can be launched from a .bat file or using the
Windows Start - Run button with the command line options:
pedigree.exe doglist.pdg /m
in the MODIFY FILE mode

which will open doglist.pdg file

pedigree.exe doglist.pdg /a
which will open doglist.pdg file
in the APPEND TO FILE mode
Any other flag or no flag will open the file as READ ONLY.
If you drag and drop doglist.pdg on to pedigree.exe in Explorer, the program will open with the file doglist.pdg loaded in
the READ ONLY mode.

Note Files If a green bar appears in the box next to the NOTES button, there is a note file for the dog entered in the NAME box that
can be loaded and reviewed, or edited and resaved.
If the box is blank, clicking on the NOTES button, typing
the entries, and clicking SAVE will create a data file and note for
the dog currently in the NAME box.

When typing notes do NOT use the character ( ¿ ), ANSI
(191). This special character is used as a delimiter in the dog's
record (.REC) file and is reserved for that purpose.
If you want to use the SEARCH capability for Breeder,
Owner, CERF, OFA, or BAER, it is important to fill in these data.
Since the SEARCH method looks for exact matches, be sure
that these data are entered in a uniform format that can be used
to satisfy your search criteria. Date of Birth information can be
entered in any recognizable format, e.g., Sept 21, 1997 or 9/
21/97.
You can print the NOTES and subsidiary information by
selecting Print Notes from the FILE menu.

Merging Dog Lists Two different dog list files can be merged into a common
file, but the program limit of 32,767 entries per list may not be
exceeded. Duplicate entries will be eliminated, and the index
numbers of the entries will be renumbered. Linkages to sire
and dam entries will conform to those already set in the first of
the merged files.
If you select a NEW folder for the merged dog list file (not
the folder that contains either source file), then the merging routine will also copy all the associated record (.REC) and picture
(.BMP) files into the new folder along with the new merged dog
list. It will automatically rename these files to match the new list
ordering. It is recommended that you use this method to minimize loss of records and/or the need for extensive manual editing and copying.
If, however, you choose instead to place the merged dog
list into one or the other of the folders that already contains one
of the dog lists that is to be merged with the other, you will need
to manually copy and rename the associated files. If one of the
dog list files to be merged is associated with all or most of the
dog records and pictures or has the most recent information,
then select this as the first of the files to be merged. This file
will comprise the first part of the merged file and the assigned
dog index numbers will not be changed. The second file selected for merging will be added to the end of the first file, duplicates will be deleted and the index numbers will be shifted by
the number of dogs in the first list less the number of duplicates
that were deleted.

If you choose to place the merged dog list file in a new
folder, then the program will attempt to copy and renumber the
records into the new folder. Records for dogs from the source
file, file 2, will not be copied if there are duplicate records from
the source file, file 1.
The source file, file 1, is the primary list for the record data:
sire, dam, titles, registration, breeder, etc. These are the data
that by default will be used to construct the merged list. However, since source file 2 may in some cases contain data which
is more recent, it is possible to obtain a text file, duplicts.txt,
which provides a line-by-line comparison of the duplicated
records. The file, duplicts.txt, will be placed in the merged file
folder. Not all duplicated records, but only those that are different, will be included in the duplicts.txt listing. The text file can
be opened in a text editor such as Notepad and can be used to
manually edit the merged doglist file to insure that this file contains the most recent information.
If you find that the pictures, medical, show, etc. records of
the duplicates from source file 1 are not the most recent in every case, you can replace these by copying the corresponding
files from the source file 2 folder. For these manually copied
files, you will need to renumber the dog records (.REC) and
pictures (.BMP) to conform to the new numbering indices of the
merged file. To do this identify the dog's new index number by
selecting it from the dog list. Then rename all associated files
for that dog by replacing the old index number in the record
filename with the new index number.

Deleting Dog List Entries If you must delete an entry, you should first assure that
there are no sire or dam links to the entry you want to delete. If
there are, you will need to link these to the correct entry (or to
the blank, list index number 1) while in the MODIFY FILE mode.
An entry can be deleted by double clicking on the entry name in
the list box and then clicking the DELETE button which will appear. When the file is saved from the FILE menu, the list of
dogs will decrease by the number of entries deleted and the
index numbers will be shifted accordingly.
Record files and picture files will be renamed to correspond
to the correct dog.
IMPORTANT: Records and picture files that are associated
with dog names that are deleted will also be deleted when the
file is saved.

Options Menu options selections including background color, font
type and size, and file merging selections. Your current preferences and also the dog list files that have been created and
saved will be entered in the file, PEDINI.INI, which will set up
these same selections the next time the program is started.
If you select COLOR and then SELECT WALLPAPER, you
can personalize the background display using a .BMP file of
your own or one of the files in the WINDOWS directory.

Organizing the Files If only one dog list is used then all the files and the PEDIGREE program can be kept in the same directory.
If more than one dog list is maintained for different breeds
or breeding lines, then it is best to put the PEDIGREE.EXE,
PEDIGREE.HLP, PEDIGR.INI, OBEDFIL.SET and
TITLEFIL.SET files in a separate directory with separate
subdirectories set up for each different dog list (.PDG files).
The associated record files and pictures for each dog list should
be put in their corresponding subdirectories.
This is necessary since records for dogs from different dog
lists will share the same index numbers and therefore their
record files will have the same file names. These records will
automatically be placed in the same subdirectory with their corresponding dog list (.PDG file) when they are first created, so
you will only need to make certain that the dog list files (.PDG
files) you set up are not in the same subdirectory. When you
scan in the dog pictures, scale them, convert to .BMP, and
name them according to the convention (see: Picture Box), be
sure to put them in the correct subdirectory.

Scanning the Pedigree It is possible to quickly scan the pedigree of the dog selected in the Name Box when a file is opened for Read Only.
Begin by selecting a name from the list. When you click on
the Sire (or the Dam) button, the Sire (or Dam) will replace the
selected entry in the Name Box and the new sire and dam will
be placed in the corresponding boxes. Notes, pictures and
records can be viewed for the ancestor that is currently entered
in the Name box.
You can move backward by clicking the B button. You can
move forward by clicking the F button.
The B and F buttons, which are enabled only in the Read
Only mode, recall any of the 20 most recently accessed dogs
whose names are stored in a list. When the list is filled with 20
names, the next dog accessed will be placed at the top of the
list and the oldest access will be dropped from the list.

Printing Pedigree or Progeny Files A pedigree file can be created for the dog entered in the
NAME box by using the PRINT PEDIGREE FILE selection under the FILE menu.
The pedigree will include current entries and/or changes
only if the file from which it is taken has previously been saved
using the SAVE command under the FILE menu.
A question box is dropped and data may be entered to
include on the pedigree output file. After the desired data entries have been made, clicking the OK button clears the question box. A file name (which should have a .TXT extension)
should be entered when requested or the default name can be
accepted. The pedigree file will be saved with the default file
name PEDIxxxx.TXT (where xxxx is the ID number of the dog),
and will be saved in the PEDFILES subdirectory of the current
directory.
The pedigree text file can be edited using any ASCII text
editor, but in most cases it will only appear normal if landscape
orientation is selected, the font selected is a monospace font
such as COURIER, and the selected font size is small enough
so that lines do not wrap.
If you check the box "Create List File", a text file listing,
LISTxxxx.TXT (where xxxx is the ID number of the dog), which
is a list of the ancestors in the pedigree will also be created and
will be saved in the PEDFILES subdirectory of the current directory. The list file is needed to use MS Word or MS Excel tem-

plates; it is also needed to produce HTML pedigrees for web
publishing. The default setting (checked or unchecked) for
generating list files is retained until it is reset by the user.

Similarly, selection of the PRINT PROGENY FILE option
will create a 6-generation descendents list to a text file for the
dog currently entered in the NAME Box. If you have a color
printer and would like your printout to color code champions
(titles preceding names), you can select among the colors:
black, blue or red for printing these names.
The formatted pedigree or progeny files can be edited before printing, or they can be previewed and/or printed directly
from this program. You will be cautioned to set the printer to
landscape mode so that the printout can fit on a standard 11" x
8.5" page. More than one page may be needed for long progeny files. If you choose to print directly and a picture of the dog
is available, it will be inserted in the printout. To print directly
from the program you can choose to preview each page first,
uncheck the preview only check box and then print each page
in succession.
HTML Files By selecting the option Create HTML Pedigree from the
FILE menu, you can produce a 4- or 5-generation pedigree file
in HyperText Markup Language (HTML). You must first open
the list of dog names, select the dog for which you want to make
the HTML file, and ensure that the selected name appears in
the NAME box.

After the dog name has been selected, clicking on the menu
option, Create HTML Pedigree, formats a 4-or 5-generation
standard pedigree as a table with champions colored red. The
file is saved in the HTMFILES subdirectory of the current directory as PEDxxxxx.HTM, where xxxxx is the ID number of the
selected dog. This file can be used alone, or it can be edited
and inserted into another web page.
Other options for HTML pedigrees call the routine that
computes the Wright's Coefficient of Inbreeding, COI. The COI
for the selected individual and all the ancestors in the pedigree
is printed as part of the HTML file. The COI computation uses
6, 8 or 10 generations for the selected dog provided that the
pedigree data is sufficiently complete. Another option produces
HTML pedigrees for the additive relationship and Relationship
Coefficient of two dogs that are selected as sire and dam for
Test Breeding. Genetic Risk evaluations are also produced using the HTML format.
If you select the inbreeding pedigree option, you can select
the number of generations of pedigree data used to calculate
the COI. You can generate the pedigree and COIs for all the
ancestors that are displayed from this data set. This means that
fewer generations of data will be used in computing COIs for
great grandparents than parents, for example. Or you can
have the COI calculations based on the same number of generations for each ancestor. The latter option can require considerably more time.

It is also possible to generate a Genetic Risk Pedigree in
HTML format. Such a pedigree will list the probabilities for affected and carrier status of the selected dog and its ancestors.
The VIEW menu option for the HTML file will attempt to
locate the default web browser program and launch that application to preview the pedigree. If you move or replace your default browser program, this program may be unable to locate the
browser to view the HTML pedigree. To reset the browser location you must delete the PEDIGR.INI file.
The routine for formatting the HTML file will insert the selected dog's picture and personal information, e.g., Date of
Birth, Breeder, Owner, etc, if these data have been entered for
the selected dog. The page background color and picture will
be the same as that selected for the opening program form and
can be set under the menu - options - color - select color dialogue.
To set both the background color and background picture
for the HTML page, first select the color you want and click OK
on the color dialogue. Then re-open the dialogue and select the
background picture and again click OK. The background color
sets the color in the pedigree table. The picture is the wallpaper
for the remainder of the HTML page.
Alternatively, you can opt to produce a bare-bones HTML
pedigree with little formatting. This option will usually produce
pedigrees that can be printed on a single page.

Building Pedigrees using Templates If you have MS Word or MS Excel programs on your computer and have downloaded templates or worksheets for pedigree formatting, you can call the applications from the pedigree
program menu.

When the application is run from the menu, the template or
worksheet will be loaded at startup. The first time you run the
app you will be asked to locate and select the template. The
pedigree program will store the path in the .ini file so it will not
be necessary to locate these files again unless the .ini file is
deleted.
The template (.dot) and worksheet (.xls) files should have
their properties set to "Read Only" to avoid overwriting these
files and rendering them unusable. With the app running you
can select the desired pedigree list file and execute the macro

as discussed in the template documentation.
Note that the usual procedure for using MS Word templates is to start a new document and then select the desired
template. Using the call from the pedigree program menu you
will actually be constructing the pedigree on the template (.dot
file) rather than as a new document (.doc file). If you merely
want to print out the pedigree, this poses no problem. On the
other hand, if you want to save the pedigree that you have constructed, it can be done in two ways:
1. You can save the pedigree directly as a new template
(with a new name so as not to overwrite and thereby destroy the
old template), or
2. Choose "Select All" and then "Copy" from the MS Word
menu. Then start a new document and "Paste" from the MS
Word menu.
The second approach is recommended since the resulting
.doc pedigree will use far less space than the .dot pedigree resulting from the first method.

HTML Registry The HTML registry is a convenient way to organize and
access your HTML pedigree files. These files are stored in a
subdirectory, Htmfiles, of the folder that contains your dog list.
The registry can be accessed from the main page menufiles-View HTML Registry and then selecting the category of
HTML files you want to review. The available pedigrees are
listed by the dog's name (or identification number in the case of
relationship or test mating pedigrees). Select the dog's name
from the list and then click on View to open the file in your
browser. The file can also be deleted by selecting it from the list
and clicking on the Delete button.

Printing Show Entry Forms Show entry forms can be printed for the dog entered in the
NAME box by using the PRINT SHOW ENTRY selection under
the FILE menu.
Selecting this menu item will bring up the selections: PREVIEW ONLY and PRINT ENTRY. Unless the show data have
already been entered, select PREVIEW ONLY and enter the
data for your dog in the appropriate slots (four forms for data
entries are provided). After all the required data have been entered, save and then print to preview the entry on the screen. If
the data is correct, you can set up your printer to landscape orientation and then once again select PRINT SHOW ENTRY and
then PRINT ENTRY.
Once data have been saved for the specified dog, it should
only be necessary to update show, date, fee and entry class for
subsequent entries. Data for the dog indexed as number 2, for
example, will be saved in the Entry Data section of the file:
0002PEDI.REC.
This printing routine requires that the Arial font be available
and that all the entry data fit within the margins of your printer.
If font substitutes are made by the Windows operating system
or if there is insufficient space inside your printer's margins, the
form will not print properly.

Picture Box If a picture of the dog in the NAME box exists in the
proper format and with the properly indexed filename in the current directory, a green bar appears next to the PICTURE button
and the PICTURE button is enabled. Clicking on that button
will load the picture. It is automatically unloaded when a new
dog name is selected for the NAME box.
The scanned color or grayscale picture must be in the
BMP (Windows) format with a size of about 200 x 200 pixels
depending on your screen display resolution and must be
named according to this convention: (three number index with
leading zeroes, if required) & PICT.BMP, e.g., 0002PICT.BMP is
the filename for the picture file for the dog with index number 2.
If the photo has been scanned in another format it should
first be converted to BMP format before it can be used in the
Pedigree program.
Pictures in one of the formats: .DIB, .WMF, .GIF, can be
loaded into the picture box (PICTURE - OPEN PICTURE
menu) when the dog's name is displayed in the name box. If
the autosize option in the picture menu is checked, the picture
will be scaled to fit the display. When saved, it will be indexed
to the selected dog and saved in the current directory as a
.BMP file.

Opening and Saving Pictures A picture of the dog entered in the NAME box that is not already
indexed to that dog can be opened and displayed.

If the picture file is in the appropriate format (.dib, .bmp,
.wmf, .gif) and is the proper size for display (depending on the
screen resolution, the picture should be about 100 to 250 pixels
in both height and width), it can be opened for use with the
PEDIGREE program. Selecting AUTOSIZE PICTURE will assure that the picture is scaled to fit the display. If the dog list is
opened in the Modify mode, clicking on SAVE PICTURE will
copy the picture to the current directory and will rename the file
so that it is indexed to the selected entry.
Depending on the color depth of your display, color quality
may deteriorate. If the 256 color mode is in use, the picture will
be saved as an 8-bit BMP file which will often lead to
compomise in color quality. Greater color depth will generally
give better results and avoid the usual competition for the windows palette. MS Visual Basic sometimes saves BMP files in a
format that most graphics programs cannot open. Generally,
this is caused when your display is set to the 16-bit, high color
mode. Not all graphics programs can open a 16-bit picture file.
Opening the file using the Paintbrush program and saving the
file again from that program usually fixes the problem.

Entering Titles If the dog's title status has changed, you can type the new
titles directly in the boxes adjoining the NAME box and then
click SAVE and CLEAR.
An easier approach uses the selections from the PRETITLE and the POST-TITLE boxes. Select the Pre-Title and the
Post-Title (select the blank if there is no title) and click the Insert
Title button, or simply double-click any of the available selections individually. Double-clicking a title will add that title at the
end of the previous titles. Double-clicking the blank will clear all
titles. Typing a frequently used name in the top box if it is not
already in the list will allow that title to be used multiple times
until another selection of titles is made.
A new entry typed in the top box of the selection list will
be added to the list of titles and will be saved to a file
(TITLEFIL.SET or OBEDFIL.SET) when the project is saved
using the SAVE command under the FILE Menu.
These title selection lists are text files and can be deleted,
edited, or added to manually using the WINDOWS Notepad
program. The title abbreviations that are included with these
files are the AKC recognized titles and are defined as follows:
Titles Appearing Before a Dog's Name (TITLEFIL.SET)
* CH - Champion
* FC - Field Champion (Field Trial/Lure Coursing)
* AFC - Amateur Field Champion
* NAFC - National Amateur Field Champion
* CT - Champion Tracker

* NFC - National Field Champion
* OTCH - Obedience Trial Champion
* HC - Herding Champion
* DC - Dual Champ (CH & FC)
* TC - Triple Champ (CH, FC & OTCH)
Titles Appearing After a Dog's Name (OBEDFIL.SET)
* CD - Companion Dog
* CDX - Companion Dog Excellent
* UD - Utility Dog
* UDX - Utility Dog Excellent
* TD - Tracking Dog
* TDX - Tracking Dog Excellent
* VST - Variable Surface Tracker
* JH - Junior Hunter
* SH - Senior Hunter
* MH - Master Hunter
* HT - Herding Tested
* PT - Pre-Trial Tested
* HS - Herding Started
* HI - Herding Intermediate
* HX - Herding Excellent
* JC - Junior Courser
* SC - Senior Courser
* NA - Novice Agility
* OA - Open Agility
* AX - Agility Excellent
* MX - Master Agility
* JE - Junior Earthdog
* SE - Senior Earthdog
* ME - Master Earthdog

Wright's Coefficient of Inbreeding References:
1. Genetics for Dog Breeders, by Frederick B. Hutt, W.H. Freeman, pubs.,1979, p 206.
2. Genetics 0f the Dog, by Malcolm B. Willis, Howell Book
House, pubs., 1989, pp 320- 332.
Wright's coefficient is the most commonly used measure of the degree of inbreeding. The coefficient, FX , tells us
the proportion of genes for which the inbred animal is likely to
be homozygous. (Reference 2). To be more precise, FX , when
calculated for a limited number of generations, tells us the relative level for which the inbred animal is homozygous compared
with the average level of homozygosity for the breed as a whole.
FX is calculated as the sum of 1/2 raised to the power of (n
+ n’ + 1), where n is the number of generations from the sire
back to some ancestor common to both the sire and the dam, n’
is the number of generations from the dam back to the same
common ancestor, times the factor, (1 + FA), and the summation
is over the separate contributions of each different common ancestor.

FX = Σ (1/2)n+n’+1 (1 + FA)
FX is the coefficient of inbreeding of the animal, x
FA is the coefficient of inbreeding of the common ancestor,
A, when that animal is itself inbred

In many cases, it is advantageous to first calculate an approximate coefficient (reference 1) as:

Fx = Σ (1/2)n+n’+1
This formulation is a simplified computation which disregards possible inbreeding of the common ancestors. The coefficient is a measure of the degree of relationship between the
dog's sire and dam. A mating of brother to sister, for example,
yields an inbreeding coefficient of 25%.
It is important to observe that the COI will be zero if there
are no common ancestors on both the sire’s and dam’s sides of
the pedigree. This is true regardless of the number of times
that the same ancestor appears in the background of the sire
(or the dam) alone.

Coefficient of Relationship References:
1. Genetics for the Animal Sciences, by L.D.VanVleck, E.J.
Pollak, E.A.B. Oltenacu; W.H.Freeman, pubs., 1987, pp 199 et
seq.
2. E.J. Pollack, private correspondence: Computer implementation of Quaas-Henderson procedure.
The total genetic covariance between two individuals consists of several parts. The most important of these is the additive relationship which is a measure of the fraction of genes
shared by the two individuals. It is a measure of the covariance
of the breeding values of the two relatives. It is important in devising weighting factors for records of relatives in genetic evaluation.
The additive relationship, Ryz, has a simple relationship to
Wright's coefficient of inbreeding, Fx. R can easily be calculated for two animals by first calculating the hypothetical COI of
an animal produced by mating the two individuals (regardless
of the sex of these assumed parents). The additive relationship
between the two animals is then calculated as twice the COI of
the hypothetical offspring.

RYZ = 2 FX, where FX is the coefficient of inbreeding of
the hypothetical offspring of individual Y and individual Z.
The additive relationship has a minimum value of zero and
a maximum value of two.

The Coefficient of Relationship is a measure of relationship
that has a minimum value of zero and a maximum value of one.
It is equivalent to the correlation between breeding values of the
two animals, For noninbred animals, the coefficient of relationship is the same as the additive relationship. In general, the
coefficient of relationship is:

RYZ / [ (1 + FY)(1 + FZ) ] 1/2
where FY and FZ are the inbreeding coefficients of animals Y
and Z, respectively.
The additive relationship and the Relationship Coefficient
of two dogs that are selected as sire and dam for a Test Breeding can be computed and a pedigree generated in HTML format. Open the dog list for Append, select Set Up Test Breeding
under the Options menu, and enter the dogs' names as sire and
dam of the test breeding (regardless of the sex of the two dogs).
Click Save and Clear, then select under menu File - Create
HTML pedigree - Relationship pedigree.

COI Batch Calculations From the Options menu select COI Batch Job to compute
the coefficients of inbreeding for a subset of the dogs from the
dog list file that is currently open.
To compute COIs for an ordered set of dogs:
1. Enter the ID number of the first dog of the set followed by
a carriage return in the Start ID box of the top frame, Sequential
Subset. The name of the first dog will appear in the Start Dog
Name box.
2. Enter the ID number of the last dog of the set followed
by a carriage return in the Stop ID box. The name of the last
dog will appear in the Stop Dog Name box.
3. The number of COI runs to be computed will automatically be entered in the No. of Runs box.
4. Enter the number of generations of pedigree data that
should be used for each dog (3, minimum, to 14, maximum) or
accept the default of 10 generations. This number should be
entered in the box under Generations.
5. Click the Start button to initiate the batch computations.
Depending on the speed and available memory of your computer, the number of generations, and the number of runs, the
job may take a few minutes or several hours. Progress can be
judged by observing the percent completed entry in the
Progress box and also by noting the countdown in the No. of
Runs box.

To compute COIs for a random set of dogs:
1. Enter the ID number of the first dog of the set followed
by a carriage return in the Start ID box of the bottom frame,
Random Subset.
2. Enter the ID number of the last dog of the set followed
by a carriage return in the Stop ID box.
3. The number of COI runs to be computed for randomly
selected dogs must be entered in the No. of Runs box. Dog IDs
will be drawn using random selection within the span between
the start and stop IDs. For small spans and a large number of
runs the same dog may be selected more than once.
4. Enter the number of generations of pedigree data that
should be used for each dog (4, minimum, to 20, maximum) or
accept the default of 10 generations. This number should be
entered in the box under Generations.
5. Click the Start button to initiate the batch computations.
After completion of the batch job, the results by default will
be saved as a text file, Batchxx.txt. If you select the .csv option
you will be asked to select the field delimiter for the output data.
You will be given the option to preview the file or you can open
and/or print it later using Notepad (or Excel if you choose the
.csv option with a comma as the field delimiter).
You can also view a histogram of the COI results for the
subset of dogs by clicking on the Graph button.

Genetic Risk Pedigree You may select up to three genetic risk traits that are
found in your breed or breed line. These hereditary diseases or
defects should be added to your preferences by selecting Preferences under the Options menu.
With a dog list open for Modify, select a dog from the list
and click on the Name button so that the dog's name is displayed. If you have information about the dog's status with respect to each of the genetic risks that you have chosen, place
the appropriate letter in the Genetic Risk Factors boxes:
A - the dog is known to be AFFECTED for this defect,
C - the dog is known to be a CARRIER for a defective gene
but is not affected,
U - the dog is UNAFFECTED but could be a carrier,
N - the dog is NEITHER affected nor a carrier,
P - the dog is known to have PRODUCED an affected offspring but its carrier/affected status is not known.
after typing the appropriate letters in the risk boxes, click on the
Save and Clear button. If no entries are made in the risk boxes,
the dog will be considered a typical representative of the breed
with the breed-average affected and carrier probabilities.
By selecting Genetic Risk Pedigree from the File menu, a
pedigree can be created in HTML format for the dog that has
been selected from the list and whose name appears in the
Name box. This pedigree must be viewed using a web browser
that can be launched by selecting View HTML Pedigree from

the File menu. This pedigree will color-code the ancestors for
which genetic risk profiles have been entered. The probabilities
that the selected dog or its ancestors is affected or is a carrier
are printed under the names.
When you select this option, you will need to select the
desired trait from the preferences you have chosen, the number
of generations to consider in generating the risk probabilities
(only 5 generations will be displayed), the mode of transmission of the selected trait (autosomal recessive or sex-linked),
and the average breed incidence of affecteds.
For autosomal recessive traits the percent carriers and percent clear are computed using Hardy-Weinberg assumptions
based on the the average breed incidence that you enter.

p² = a
where a is the average breed rate, p is the gene frequency and
p² is the rate of affecteds.
For sex-linked traits the distribution of affecteds between
males and females is as follows:

0.5 p + 0.5 p² = a
where a is the overall average breed rate, p is the rate of af-

fected males and p² is the rate of affected females.
Many hereditary traits are simple autosomal recessives,
and a very small number are sex linked. However, many genetic diseases are, in fact, polygenic, and although a risk profile
for such defects may be of interest, it cannot be expected to provide accurate results.

